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INTRODUCTION
This tutorial introduces the concepts of multiaxismachining, beginning with the machine architecture and ending
withmultiaxis toolpath creation. Multiaxis toolpaths are basically the familiar contour, pocket, and surface toolpaths
in X, Y, and Z, with rotationalmotion added in A, B, and C. The available axes vary based on your particular machine
setup.

The workflow is consistent regardless of the multiaxis toolpath selected. Mastercam'sMultiaxis interface follows a
uniform structure through the toolpathing process. Select the toolpath family, select a toolpath type, progress
from top to bottom through the tree-style interface, enter parameters on the necessary pages, and generate the
toolpath. Additional tools such asMastercam Simulator andMachine Simulation allow you to review your toolpath
before cutting begins on the machine.

By completing this tutorial, you gain a general understanding of the multiaxis process. The information contained in
these pages gives you the knowledge and confidence to work withMastercam’smultiaxis toolpaths.

Goals

l Understand the basic architecture of amultiaxismachine

l Review the controls of amultiaxis toolpath: cut pattern, tool axis control, and tool tip control

l Follow the workflow of Mastercam'sMultiaxis toolpath interface

l Create andmodify aMultiaxis Curve toolpath

l Create andmodify aMultiaxis Drill toolpath

MastercamMultiaxis Tutorial Requirements
l Mastercam2019 withMill or MastercamRouter

l Curve 5-axis / Drill 5-axis Add-In (included in the Multiaxis Add-In) 

WARNING: Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not affect the lesson or
your results.

Estimated time to complete this tutorial: 1.5 hours

General Tutorial Requirements
All Mastercam2019 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operating system.

l The tutorials cannot be used withMastercamDemo/Home Learning Edition. The Demo/HLE file format
(emcam) is different fromMastercam (mcam), and basicMastercam functions, such as file conversions and post-
ing, are unavailable.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you com-
plete them in order.

Mastercam Multiaxis Tutorial—Introduction



l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be access from the Mastercam2019 workstation, either with the
tutorial or in any location that you prefer.

l Youwill need an internet connection to view videos that are referenced in the tutorials. All videos can be
found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.

Mastercam Multiaxis Tutorial—Introduction
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CHAPTER 1
BASIC MACHINE OVERVIEW

With amultiaxismachine, instead of a straightforwardmachine with XYZ axes capabilities, you have amachine that
can handle five or more axes of motion. Typically, the axes are defined as XYZ/ABC/UVWas shown below.

The axesmay be in a different orientation or have different relationships. Your machine nowhas amuch greater
range of motion than a standard 3-axis vertical or horizontalmachine.

The addedmotion of amultiaxismachine enhances the capabilities of your shop, as well as expands the variety of
parts that you canmachine. Nearly every machine is unique in its axes combination, orientation, travel and rotation
limits, and controller.

Common terms for multiaxismachines are Table/Table, Head/Table, andHead/Head. These terms describe the
relationship of the rotary components on the machine. The configuration of the rotaries determines the zero loc-
ation of the machine and how you need to locate the part withinMastercam. The part must be located inMastercam
where it will be sitting on the machine. The only exception is for a Head/Head arrangement.

CAUTION: Improper location of your geometry will cause the part to be cut incorrectly.
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Table/Table Machine
A Table/Tablemachine has both rotary axes connected to the table. Typically this is a trunnion carrying a rotary
table. The machine axes zero position is located at the intersection of rotary axes. Your part is located inMastercam
relative to the machine zero position. The rotary components are pointed out in the following image, which is a
Table/Table configuration withmachine zero.
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Head/Table Machine
A Head/Tablemachine has one rotary on the table and the other on the spindle. They operate independently of
each other. The table could be comprised of a trunnion or simply a rotary attached to the table. The machine axis
zero is located at the intersection of the rotary axes. Your part is located inMastercam relative to the machine zero
position, as in the Table/Table configuration. The rotary components are pointed out in the following image, a
Head/Table configuration withmachine zero.
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Head/Head Machine
A Head/Headmachine has both rotary axes connected and attached to the spindle. The machine axis zero is typ-
ically located on the face of the spindle. The origin is shown on the table as this is where the spindle face lies when all
axes are set to zero. The rotary components are shown in the following image, aHead/Head configuration with
machine zero.

These are the basic arrangements of multiaxismachines. Be aware that multiaxismachinesmay be as simple as a
single rotary for 4-axis work, or as complex as having five axes and a nutating head. Nomatter how the machine is
configured, the inputs for a good toolpath follow the same pattern frommachine to machine. Continue on to the
next chapter to learn about the necessary controls for creating an efficient multiaxis toolpath.
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CHAPTER 2
MULTIAXIS TOOLPATH CONTROLS OVERVIEW

Three controls separate multiaxis toolpaths from the typical 2- and 3-axis toolpaths:

l Cut Pattern

l Tool Axis Control

l Tool Tip Control

Effective use of these controls is the deciding factor in your ability to create efficient toolpaths for your particular
machine. This tutorial starts you on the path to becoming amore effective programmer. However, there is no sub-
stitute for experience and knowing your machine’s capabilities.

Cut Pattern
What do you want the tool to follow? The answer is the Cut Pattern. Selecting a toolpath family is the initial phase of
establishing the cut pattern. Different toolpath families vary the type of geometry allowed for the cut pattern. Geo-
metry selection can range froma contour or chain, to a surface edge or edges, and on through single or multiple
surfaces or solids. Below are two examples of cut pattern selections.

3D Curves Surface

In addition to the geometry selected for the toolpath, cut pattern includes such parameters as:

l Cutting method: Zigzag, One way, Spiral

l Compensation: Type and Direction

l Stock to leave: Drive surfaces, Walls

l Stepover: Across, Along, Increment

Subsequent chapters cover cut pattern options inmore detail.
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Tool Axis Control
Howdo youwant the tool axis to behave as it follows the cut pattern? Tool axis control answers this question. Mul-
tiaxis toolpaths include numerous options on how tomanipulate the tool axis. The options allow you to control the
part of the tool in contact with the material, and the amount of toolmovement the toolpath generates, as well as
being able to set the number of axes of output for the posted toolpath. Below are two examples of tool axis control.

Surface

From point

Toolpath family and toolpath type determine which tool axis controls you can access. Some examples of the controls
available include:

l Lines, surface, frompoint, chain

l Fixed angle to axis, be tilted relative to contact point

12
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l Rotated around axis, frompoint

l Parallel to line, surface, plane

Tool Tip Control
What controls the depth of the tool along the tool axis? Tool tip control handles this function. Compensation sur-
faces are included in tool tip control. Applying tool tip control is a three step process:

1. Tool positions are generated along the selected cut pattern.

Mastercam Multiaxis Tutorial—2: Multiaxis Toolpath Controls Overview



2. Tool axis vectors are created at each position based on the tool axis control settings.
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3. Depth along the tool axis is applied based on the tip compensationmethod.

Note: Use the method depicted above when you have very complicated, or less than perfect, part geometry. The
clean core geometry is used to generate the cut pattern and tool axis control vectors. Tip control is then used to cut
the outer surfaces withmuch cleaner motion.

The three controls described previously form the core of all your multiaxis toolpaths. Additional refinement is
added through collision control, linking, tool selection, andmore. Building confidence with these controls will greatly
ease and enhance your ability to generate efficient multiaxis toolpaths. Continue on to Lesson 3 to see how these
controls are an integral part of the multiaxis workflowwithinMastercam.

Mastercam Multiaxis Tutorial—2: Multiaxis Toolpath Controls Overview
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CHAPTER 3
MASTERCAM INTERFACE AND WORKFLOW

Mastercam’sMultiaxis toolpath interface follows the familiar tree-style layout. You progress through the pages of
the tree, make the necessary selections, enter appropriate parameters, and generate your toolpath. Viewing the
process in simplified terms helps to lessen the complexity of creating amultiaxis toolpath.

Begin the toolpath creation process by selecting an appropriate machine definition. This applies to all toolpath types
inMastercam. After selecting amachine definition that supportsmultiaxismovement, choose aMultiaxis toolpath
from theMultiaxis gallery on the Toolpaths contextual tab. The following image shows the starting point for a
Curve toolpath.

Multiaxis toolpaths are divided into two toolpath families, Pattern and Application. Each toolpath family contains dif-
ferent toolpath types.

Pattern toolpaths are general toolpaths that can be used in a variety of ways to manufacture your part. These
toolpaths are very flexible and provide awide range of machining options. Application toolpaths are designed to
solve particular machining problemswhile automating some of the processes. These toolpaths include machining
options and strategies specific to the application.

Selecting the most efficient type will come fromexperience and usage. For now, you focus on the general workflow
rather than specific applications.
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The tree structure provides the basic roadmap to creating a toolpath. While you can select the pages as needed, the
most efficient route is from top to bottom. Click the plus sign before any page to expose additional pages for input.

The pageswithin the tree structure vary with the toolpath type. The procedure remains the same regardless of
what the tree looks like. If you can answer the following questions, you are well on your way to generating amul-
tiaxis toolpath:

l What do I want the tool to follow?

l Howdo I want my tool axis to behave?

l What controls the depth along the tool axis?

18
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Cut Pattern Page
The controls discussed in the previous chapter are pivotal for multiaxis work. The Cut Pattern page is where you
select your drive geometry, set compensation parameters, and set various other options. Below is the Cut Pattern
page for a Curve toolpath.

Tool Axis Control Page
The Tool Axis Control page defines the tiltingmotion of the tool axis as it moves along the cut pattern. The options
available vary by toolpath type, just as the tree structure and other pages vary. Tool axis control is what setsmul-
tiaxis toolpaths apart from2- and 3-axis toolpaths. The ability to manipulate the tool axis allows for complex and
powerful control. Below is the Tool Axis Control page for a Curve toolpath.

Mastercam Multiaxis Tutorial—3: Mastercam Interface and Workflow



Collision Control Page
Tool tip control is found on the Collision Control page. Use the parameters to instruct the toolpath how the tip of
the tool should be placed in relation to the cut pattern. Below is the Collision Control page for a Curve toolpath.

Complete the remaining pages in the tree if necessary. Additional parameters include linking information (how the
toolmoves when not in contact withmaterial) and roughing options. The Additional Settings branch provides
pages that generally do not need to be touched for multiaxis programming. Continue on to the next chapter to
begin creating a Curve toolpath.

20
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CHAPTER 4
MULTIAXIS CURVE TOOLPATH

Experience with design and toolpath creation is assumed at this point of the tutorial. Detailed steps on such actions
as selecting amachine definition, changing the graphics view or construction plane, or making levels visible, are not
provided. Please review the Mastercam Basics Tutorial before continuing if you are not familiar with these concepts.

Goals

l Open a part file and assign amachine definition.

l Create aMultiaxis Curve toolpath.

l Backplot the toolpath.

Exercise 1: Getting Started with Toolpath Creation
Assigning amachine definition is the first step in creating a toolpath. Setting the graphics view to allow the easiest
geometry selection plays a part in visualizing your work. This exercise guides you through the initial steps involved
with creating a toolpath.

1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System Configuration dialog
box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-down list.
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d. ClickOK.

3. Open the Curve_Toolpath part file, which was provided with the tutorial.

4. Fit the geometry to the screen using [Alt+F1] or Fit on the View tab.

5. Choose File, Save As, and save the part under a different file name. This protects the original tutorial file
frombeing overwritten.

Exercise 2: Creating a Multiaxis Curve Toolpath
Creating a toolpath involves selecting the toolpath type, tool, and geometry, as well as completing the parameter
pages. Completing this process yields a program capable of cutting your part on amachine.

1. From theMill Toolpaths contextual tab, select Curve from theMultiaxis gallery.
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TheMultiaxis Toolpaths - Curve dialog box opens.

2. On the Tool page, click Select library tool.

The Tool Selection dialog box opens.

3. Click Filter.

The Tool List Filter dialog box opens.

4. SelectNone, and then select Endmill2 Sphere.

5. ClickOK to close the Tool List Filter dialog box and return to the Tool Selection dialog box.

6. Select BALL-NOSE END MILL - 8 and clickOK.

Mastercam Multiaxis Tutorial—4: Multiaxis Curve Toolpath



The tool has been added to the toolpath.

7. Select the Cut Pattern page.

8. Choose 3D Curves from the Curve type drop-down selection.

9. Click Select points next to 3D Curves to return to the graphics window for curve selection.

The Chaining dialog box displays.

10. Select the chain on the edge of the part as shown. The start position is not important for the purpose of the
tutorial. The chain should go in a clockwise direction, regardless of the start point.

Click Reverse in the Chaining dialog box if necessary.

11. ClickOK in the Chaining dialog box to return to the Cut Pattern page.

24
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12. Set the following parameters:

a. Set Radial offset to 4.0. For this particular operation, it should equal the tool radius. This parameter
sets the distance that the center of the tool is offset (left or right) based on the Compensation dir-
ection.

b. Set Cut tolerance to 0.02. This parameter determines the accuracy of the toolpath. A smaller value cre-
ates amore accurate toolpath, but may take longer to generate.

c. SetMaximum step to 2.0. This is the maximum space allowed between tool vectors.

13. Select the Tool Axis Control page.

14. Choose To point from the Tool axis control drop-down selection.

15. Click Select to return to the graphics window for point selection.
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16. Select the point as indicated.

After selecting the point, you automatically return to the Tool Axis Control page.

17. Select the Collision Control page.

18. Set Vector depth to -10.0. This parameter offsets the tool tip along the tool axis vector.

19. Select the Roughing page.

26
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20. Ensure thatMulti Passes has been deselected.

Trimming operations using a Curve toolpath generally utilize a single pass.

21. ClickOK to generate the multiaxis curve toolpath on the selected geometry.

22. Save your part file.

Exercise 3: Backplotting the Operation
Backplotting an operation allows you to review the toolmotion before any cutting takes place on the actual
machine. Backplotting should be the first step in validating your toolpath.

1. Select Backplot selected operations in the ToolpathsManager.

The Backplot dialog box opens.
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2. Select Display tool andDisplay rapid moves.

3. Select Options.

The Backplot Options dialog box opens.

4. Deselect Simulate Axis Substitution and Simulate Rotary Axis, and clickOK. This prevents your part from
spinning around andmoving out of view.

5. Click Play to begin the backplot of your toolpath.

6. ClickOK in the Backplot dialog box when you have finished reviewing the toolmotion.

28
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Exercise 4: Running Machine Simulation
Machine simulation is the next step in validating your operations. The toolmotion is shown on your part as it is posi-
tioned on your machine and collisions between variousmachine components and the part are visually apparent, as
well as reported in text on the screen.

1. On theMachine tab, select the dialog box launcher in theMachine Simulation group.

TheMachine Simulation dialog box opens.

2. Select 6_5AXGEN_VMCHTAC from theMachine drop-down.

The machine selection is saved with the part file. Running simulation on the same part file will reload the selec-
tedmachine.

3. Click Simulate to begin the machine simulation of the selected operation.

4. Use the playback buttons to review the toolmotion contained in your operations.

If you do not see the part, clickWorkpiece, which is located on the Simulation tab.

5. Exit Machine Simulation to return to Mastercam.

6. Save your part file. The same file will be used in a subsequent lesson.

Mastercam Multiaxis Tutorial—4: Multiaxis Curve Toolpath



You have now completed a basicmultiaxis Curve toolpath. Curve is generally used for trimming operations. The
motion is typically straightforward, making it an ideal toolpath for demonstrating some different tool axis control
strategies and the effects they can produce on the tool.

30
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CHAPTER 5
TOOL AXIS CONTROL OPTIONS

Tool axis control is what separatesmultiaxis toolpaths fromnormal surface, chain, and point toolpaths. The ability to
manipulate the angle of the tool, relative to the cut pattern, puts a great amount of control in your hands. The cut
speed, finish quality, and tool life can all be affected with tool axis control. Complete this chapter to learnmore
about two additional tool axis control options for a Curve toolpath.

Goals

l Open the previously saved part.

l Edit the operation’s parameters, specifically tool axis control.

l Generate the toolpath and observe the toolmotion.

Exercise 1: Copying and Editing an Operation
For this exercise, continue with your CURVE_TOOLPATH part from the previous chapter, or open the CURVE_
TOOLPATH_05 part file provided with this tutorial.

1. If you opened the CURVE_TOOLPATH_05 part file, choose File, Save As, and save the part under a different
file name.

2. Right-click on the Curve 5 Axis operation and hold the mouse button down.

3. Drag the operation to a position farther down the ToolpathsManager.

4. Release the right mouse button and select Copy after.
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5. Select 1 - Curve 5 Axis in the ToolpathsManager, and select Toggle display on selected operations.

This hides the toolpath to clean up the graphics window.

6. Select the Levels tab.

7. Select the Visible column for level 7.

8. The chain geometry that will be used for this exercise is displayed in the graphics window.

32
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9. In ToolpathsManager, click Parameters under 2 - Curve 5 Axis.

TheMultiaxis Toolpath - Curve dialog box opens.

10. Select the Tool page.

11. Enter Chain in the Comment box.

A comment helps to distinguish operations of the same toolpath type.

12. Select the Tool Axis Control page.

13. Choose Chain from the Tool axis control drop-down.

14. Click Select to return to the graphics window and open the Chaining dialog box.
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15. Select the chain as shown, and clickOK in the Chaining dialog box.

The Chain Options dialog box opens.

16. Select Closest point on chain, and clickOK to return to the Tool Axis Control page.

17. ClickOK in theMultiaxis Toolpath - Curve dialog box to accept the parameter changes.

18. Select Regenerate all dirty operations in the ToolpathsManager.

19. Backplot the operation to observe the toolmotion.

20. Save your part file.

34
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At this point in the chapter, take amoment to review the two operations created. Operation 1 uses To point for
tool axis control. The tool is always pointing at the selected point. Operation 2 uses Chain for tool axis control. The
tool is always pointing froma point on the chain, in this case, the closest point of the chain. The different options cre-
ate drastically different tool andmachine motion. The edge of the part will also have a different taper depending on
the tool axis.

Toggle the toolpath display for the two operations so that they are both visible. Notice the different tool angle. Back-
plot the operations to see the different toolmotion. Select both operations and runMachine Simulation as in the
previous lesson. A collision is reported for operation 2 before you even run the simulation. This indicates that using
the existing chain for tool axis control is not going to work on this particular machine. This does not indicate a bad
toolpath; only the fact that this toolpath will not run on the selectedmachine.

Exercise 2: Copying and Editing the Second Operation
1. In the ToolpathsManager, right-click on 2 - Curve 5 Axis and hold the mouse button down.

2. Drag the operation to a position farther down the ToolpathsManager.

3. Release the right mouse button and select Copy after.

4. Select 2 - Curve 5 Axis and turn off the toolpath display, by pressing T.

The display for operations 1 and 2 are nowboth off.

5. Select the Levels tab to open the LevelsManager.
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6. Select in the Visible column for level 8 to display the tool axis geometry. Select in the Visible column for
levels 1, 6, and 7 to hide them.

Note: You will need to change the main level in order to hide level 1. Select the Number column for level 8 to
move the main level.

7. In ToolpathsManager, click Parameters under 3 - Curve 5 Axis.

TheMultiaxis Toolpath - Curve dialog box opens.

8. Select the Tool page.

9. Enter Lines in the Comment box.

10. Select the Tool Axis Control page.

11. Choose Lines from the Tool axis control drop-down selection.

12. Click Select to return to the graphics window and open the Lines Tool Axis Control dialog box.

36
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13. SelectWindow select lines to allow you to select lines.

14. Left-click in the graphics window to create a selection window around the part, and then release the mouse
button.
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15. The part will thenmatch the picture below:

16. ClickOK in the Lines Tool Axis Control dialog box to return to the Tool Axis Control page.

17. ClickOK in theMultiaxis Toolpath - Curve dialog box to accept the parameter changes.

18. Select Regenerate all dirty operations in the ToolpathsManager.

19. Backplot the operation to observe the toolmotion.

20. Save your part file.

Review the toolmotion for operation 3. Observe how the tool axis lines up with each line as it approaches that point
in the toolpath. The axis transitions fromalignment with one line as it moves to the next. Use asmany lines as neces-
sary to achieve the desiredmotion.

Use Backplot andMachine Simulation to review the tool andmachine motion for all three operations. The subtle dif-
ferences in tool axis control put a great deal of power in your hands for generating complex toolpaths. Tool axis con-
trol is a key element to all multiaxis toolpaths, nomatter which options are available on the page.

38
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CHAPTER 6
MULTIAXIS DRILL TOOLPATH

Multiaxis drill toolpaths differ fromother multiaxis toolpaths in several ways:

l Limited cut pattern selection: points, points/lines, lines, or features

l Restricted tool axis control: parallel to line, surface, or plane

l Fewer tip control options: point, projected point, or compensation surface

The power of multiaxis drill becomes apparent on parts that containmultiple holes with center lines pointing in dif-
ferent directions. Your multiaxismachine is capable of drillingmany different holes with a single fixture setup, sav-
ing time and increasing productivity.

Goals

l Create twoMultiaxis Drill operations.

l Backplot the operations.

Exercise 1: Creating a Multiaxis Drill Toolpath
1. Open the part file Drill_Toolpath, which was provided with the tutorial.

2. Save the part file under a different name to protect the original.
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3. Select Drill from theMultiaxis gallery on theMill Toolpaths contextual tab.

4. Select the Tool page.

5. Click Select library tool.

The Tool Selection dialog box opens.

6. Select the HSS/TIN DRILL 8xDc-10.0 tool, and clickOK.

Adjust the tool filter settings as necessary to make tool selection easier.

7. Select the Cut Pattern page.

8. Set Entity type to Points.

40
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9. Ensure that Peck Drill is selected for Cycle and that Peck is set to 0.0.

Cycle selection determines the available parameters.

10. Click Select points to return to the graphics window for point selection.

The Toolpath Hole Definition function panel opens.

11. Create awindow around the visible points, as shown below.

12. ClickOK in the Toolpath Hole Definition function panel to return to theMultiaxis Toolpath - Drill dialog
box.
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13. Select the Tool Axis Control page.

14. Set Tool axis control to Surface andOutput format to 5 axis.

15. Click Select to return to the graphics window for surface selection.

16. Select the surface as shown. Rotate the geometry as needed to allow selection.

17. Press [Enter] or click End Selection when done to return to the toolpath dialog box.

18. Select the Collision Control page.

42
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19. Set Tip control to Compensation surface.

By selecting Compensation surface, the toolpath places the tool tip on the selected surfaces.

20. Click Select compensation surfaces.

The Toolpath/surface selection dialog box opens.

21. Click Select to select surfaces in the graphics window.

22. Select the Levels tab to open the LevelsManager.

23. Select in the Visible column for level 4 to display it.
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24. Select the surface as shown. Rotate the geometry as needed to allow selection.

25. Press [Enter] or click End Selection when done.

26. ClickOK in the Toolpath/surface selection dialog box.

27. ClickOK to generate the multiaxis drill toolpath on the selected points.

28. Save your part file.

44
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Exercise 2: Adding a Second Multiaxis Drill Operation
1. In LevelsManager, turn off level 1, andmake level 3 visible.

2. Select Drill from theMultiaxis gallery on the Toolpaths tab.

3. Select the Tool page.

4. Select the 10mmdrill that was used in the previous Drill toolpath.

5. Select the Cut Pattern page.

6. Set Entity type to Points/Lines.

7. The Cycle should still be Peck Drill. Set it if necessary.

8. Click Select points to return to the graphics window for point selection.

The Toolpath Hole Definition function panel opens.
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9. Rotate the part so that you can see the points and lines that were displayed when level 3 was turned on.

10. Window select the points and lines.

Note: It is not necessary to select the lines, even though the entity type is set to Points/Lines. The lines are
automatically selected as long as they end on the point.

11. ClickOK in the Toolpath Hole Definition function panel to return to the toolpath dialog box.

12. Select the Tool Axis Control page.

46
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13. CheckOutput format to be sure it is set to 5 axis. Notice how Tool axis control is set to Points/Lines. The
lines attached to the points are automatically set as the tool axis control.

14. Select Collision Control from the tree view pane.

15. Set Tip control toOriginal point.

16. Activate Tip compensation by selecting the checkbox. Set Break through to 2.0.

The Break through parameter determines how far the full diameter of the drill penetrates beyond the selec-
ted tip control geometry.
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17. ClickOK to generate the toolpath.

18. Save your part file.

Exercise 3: Backplotting the operations
1. Set your graphics view to Isometric.

2. In the ToolpathsManager, click Select all operations.

3. Click Backplot selected operations in the ToolpathsManager.
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4. In the Backplot dialog box, select Display tool andDisplay rapid moves.

5. ClickOptions in the Backplot dialog box.

6. Deselect the options shown and clickOK. This prevents your part from spinning around andmoving out of
view.

7. Click Play to begin the backplot of your toolpath.

8. ClickOK in the Backplot dialog box when you have finished reviewing the toolmotion.

You have now completed aMultiaxis Drill toolpath. While this is the simplest of the Multiaxis toolpaths, care must be
taken when selecting geometry, tool axis control, and tip controlmethods. The differences between the control
methods are subtle but can produce drastically different toolmotion.
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CONCLUSION
Congratulations! You have completed the Mastercam Multiaxis Tutorial! Now that you have mastered the skills in this
tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will addmore as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software
in the Documentation folder of your Mastercam2019 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by press-
ing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is
openMonday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to
see the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact
your AuthorizedMastercamReseller, visit www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com. For tech tips and the
latest Mastercamnews, follow us on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to see
Mastercam in action (www.youtube.com/user/MastercamCadCam)! Registered users can search for inform-
ation or ask questions on the MastercamWeb forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com.

Contact Us

For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT
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